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OpenDX 

• Started out life as IBM Visualization Data Explorer

• When the product was cancelled, IBM put it into Open 
Source and renamed it OpenDXSource and renamed it OpenDX

• Basic premise is a series of interconnected modules, 
living together in an environment called the Visual 
Program Editor (VPE)

• There are lots of provided modules

• You can also write your own
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http://www.opendx.org

http://www.vizsolutions.com

http://cs.oregonstate.edu/~mjb/opendx
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Inputs

The Structure of an OpenDX Module

Code that does 
something useful
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Steps in Creating a Vis ali ationSteps in Creating a Visualization
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Seven Steps to Creating a Visualization

1. Get the data

2. Formulate a scientific strategy.  What do you want to show?  
How do you want to show it?

3. Import the data

4. Create a simple OpenDX network

5. Incrementally embellish the network.  Save it often!

6. Choose what quantities you want to interact with.  Change 
the Interactor styles to match the quantities being modified.
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7. Create the output.
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Starting OpenDX in OSU’sStarting OpenDX in OSU s
Computer Graphics Education Lab
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Starting OpenDX on the OSU CGEL Systems

1. Start → All Programs → WRQ Reflection → Reflection X

2. In the View menu, click off X Desktop

3. Minimize the Reflection X window (the _ in the upper right corner)

4. Start → All Programs → OpenDX → DXg p

Quitting OpenDX on the OSU CGEL Systems

1. Select Quit from the OpenDX Main Menu
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2. Maximize the Reflection X window by clicking here in the Task Bar

3. In the File menu, select Exit
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The OpenDX Main MenuThe OpenDX Main Menu
and

Categories of Modules
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The OpenDX Main Menu

Get into the Data 
Prompter 
program

Run an OpenDX networkRun an OpenDX network 
without seeing the 
network

Create a new OpenDX 
network

Run an OpenDX 
network and be 
able to edit the 
network

Run the internal 
OpenDX tutorial
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Load, and be able to edit, 
one of the OpenDX 
sample networks

Exit OpenDX
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Nine Categories of OpenDX Modules

Import & Export Rendering

Realization

Transformation

Special

Structuring

Annotation Interactor

Debugging
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• AutoAxes – creates an axis box for whatever data you are plotting

• AutoGlyph – designs and produces glyphs for the data based on the data values

C ti t ti t t f i

Annotation OpenDX Modules

• Caption – creates caption text for an image

• ColorBar -- creates a colorbar to be displayed

• Format – creates a string from a number (used to create file names)

• Glyph – produces an identical glyph for every point in the data

• Legend – produces a legend to be displayed

• Plot – creates a 2D plot

• Ribbon – creates a flow field ribbon
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Ribbon – creates a flow field ribbon

• Text – displays text in 3D space

• Tube – creates a flowfield tube
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Debugging OpenDX Modules

• Describe – describes an object

• Print – prints information about a field to the Message Window
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• Export – writes data from OpenDX into a file

• Import reads data into OpenDX from a file

Import & Export OpenDX Modules

• Import – reads data into OpenDX from a file

• ImportSpreadsheet – reads data into OpenDX from a tabular file

• Include – includes or excludes points in a field based on their data values

• ReadImage – reads an image into OpenDX from a file

• Reduce – filters and resamples a field into a lower resolution

• Refine – interpolates a field into a higher resolution

• Slab – takes a positional subset of the data
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• Slice – takes a positional slice through the data

• WriteImage – writes an image from OpenDX into a file
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• FileSelector – presents a dialog box to let you select a file

Interactor OpenDX Modules

• Integer – allows the user to input an integer number

• Scalar – allows the user to input a floating point number

• Selector – allows the user to select one of a number of options

• String – allows the user to input a string

• Toggle – allows the user to select one of two options

• Vector – allows the user to input a vector
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• AutoGrid – maps a set of scattered points onto a grid

• Band – divides a field into bands

Realization OpenDX Modules

• Connect – creates triangle connections for scattered data points in a field

• IsoSurface – creates surfaces or lines of constant data value

• MapToPlane – projects a data field onto an arbitrary plane

• RubberSheet – deforms a surface field by the amount of the data value at each point

• ShowBox – creates a bounding box for display

• ShowConnections – displays the outline of connectivity elements in a field
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• ShowPositions – displays the positions in a field

• Streakline – computes an advection path through a changing flow field

• Streamline – computes a path through a non-changing flow field
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• AmbientLight – specifies the ambient light

• Arrange – creates a single side-by-side image from a collection of images

• AutoCamera – selects a good camera view of the data

Rendering OpenDX Modules

• Camera – specifies a camera view

• Display – a more elaborate image-rendering system than Image

• Image – renders and displays field data

• Light – specifies a distant (parallel) light source

• Normals – compute point or face normals for shading a surface

• Render – renders a field and creates an image

Rotate rotates field data
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• Rotate – rotates field data

• Scale – scales field data

• Shade – specifies object-shading parameters

• Transform – performs a general matrix transform of an object

• Translate – translates field data

Colormap – presents an interactive tool for specifiying color vs. data value

Special OpenDX Modules

Receiver – receives the output of a Transmitter

Sequencer – creates an animation “VCR” display

Transmitter – “wirelessly” connects a network to a receiver
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• Collect – collects objects into a group

• Inquire – returns information about a field

Structuring OpenDX Modules

• Mark – marks a new field component as “data” (e.g., for Compute)

• Remove – removes a specified component from a field

• Rename – renames a specified component in a field

• Unmark – undoes the effects of Mark
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• AutoColor – automatically color a data field (blue→green →red)

• Color – assign a color by name of by RGB values

C t f i t b i t ith ti fi ld’ “d t ” t

Transformation OpenDX Modules

• Compute – perform point-by-point arithmetic on a field’s “data” component

• DivCurl – computes the divergence and curl of a flow field

• Equalize – apply histogram equalization to a field

• Gradient – computes the gradient of a scalar field

• Histogram – creates a histogram that can be rendered with Plot

• Map – projects one field’s data onto another field’s geometry

• Measure – calculates surface area and volume of a geometry (e g isosurface)
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Measure – calculates surface area and volume of a geometry (e.g., isosurface)

• SimplifySurface – reduces the size of the triangular mesh

• Statistics – computes the mean, standard deviation, variance, minimum, and maximum of 
a field’s data
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Adding and Connecting Mod lesAdding and Connecting Modules
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Adding a Module into the Visual Editing Area

’   d d d  It’s not drag-and-drop, 
it’s click-and-click
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1. Left-click on the module category to list its modules.

2. Left-click on the module you want to add

3. Move the cursor into the Editing Area and left-click
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Connecting Modules in the Visual Editing Area

If an input tab is “down”, then it has 
already been set to a constant within the 
module itself, and cannot take an 
external connection until that constant 
h  b  t

If an input tab is in the “up” position, you 
are allowed to try to connect to it.

has been un-set.

Just because an input tab is up, however, 
doesn’t mean that this input is data-
compatible with the output you are trying 
to connect to it.  Data-compatability is 
indicated by the input tab(s) turning 
bright green.

This, however, still doesn’t imply that the 
connection makes logical sense.  ☺
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1. Left-click on the output tab of the module you are connecting from

2. Keeping the left button down, drag to the input tab of the module you are connecting to

3. When you get close, the tabs to which a connection make sense will highlight in green

4. Move the cursor on top of the tab you want to connect to, and release the left mouse button

5. To disconnect, reverse the process.  Click on the input tab and drag back to the output tab.

Some Modules Can Have Variable 
Numbers of Tabs

Edit→Input/Output Tabs→Add Input Tab
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Collect and Compute are two common 
modules that work this way
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Terrain Vis ali ationTerrain Visualization
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Import/Export

Transformation

Terrain Visualization

Rendering

Start simply, then embellish !

mjb – March 6, 2009
Oregon State University

Computer Graphics



14

Interactor

The Import and FileSelector  Modules

Import/Export
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You can type a filename into the Import 
module, but hooking in a FileSelector 
module makes it way easier and friendlier

Structuring

Interactor

Realization
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Transformation
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The Colormap Editor Module

• The first input “tab” is the field input.

• Click on the Hue Saturation Value or

Special

• Click on the Hue, Saturation, Value, or 
Opacity labels to edit that curve.

• Double-click on a line to add a control point 
there.

• Click on a control point to select it.

• Sweep a box over several control points to 
select them all.

• Hold down the left mouse button on a control 
point to move it.  If several are currently 
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selected, all will move together,

• Edit → Delete to remove selected control 
point(s).

The data value range over which the colors 
apply is determined by scanning the data itself.

The Colormap Editor in Action
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Special
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Rubbersheeting the Terrain Surface
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Special

The Image WindoThe Image Window
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Image Window Options

The AutoAxes option has many ways to 
embellish the visualization with axes, labels, 
grids, etc.
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Image Window Options

The Mode option lets you set what scene 
transformation the mouse will perform.
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Image Window Options

The View Control option lets you set various 
aspects of how the scene will appear.

Same as the Mode option

Set a pre-defined view
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Specify Perspective or 
Orthographic 3D projection

If using Perspective, this 
specifies the field-of-view 
angle.  The larger this number, 
the more severe the perspective 
will be.

Scalar Vis ali ationScalar Visualization
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Glyphs
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3D Cutting Plane – Interpolated Colors

MapToPlane interpolates the 3D field onto the given plane.  
The first argument is the field, the second is a 3D point on 
the plane, and the third argument is a 3D normal to the plane.

Realization
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3D Cutting Plane – Contours

Realization

mjb – March 6, 2009
Oregon State University

Computer Graphics

Isosurfaces
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Realization
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Direct Volume Rendering
A Volume Rendering “Transfer Function” relates data scalar value to 
its corresponding color and opacity.  For volume rendering, OpenDX 
uses the color Value as the opacity, not the color Opacity.

The direct volume 
rendering part of the 
Image module will only 
work in Orthographic 

These are the 
“Transfer Function”

work in Orthographic 
projection.

mjb – March 6, 2009
Oregon State University

Computer Graphics

Vector Vis ali ationVector Visualization
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Vector Cloud

Annotation
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Speed Isosurfaces
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Streamline Ribbon

Realization
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Streamline Tube

Annotation
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Curl

Transformation
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Divergence

Transformation
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